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INTRODUCTION 

What is a PivotTable 

A pivot table allows you to quickly create reports with meaningful data.  It is a great reporting 
tool that sorts and sums independent of the original data layout in the spreadsheet.  

 Information can be pivoted from one axis to another to display different relationships in the data 
thus, permitting the viewing of data from varying perspectives.   

 Choosing Appropriate Data for a Pivot Table 
Before you begin setting up a PivotTable be sure your source data (Excel worksheet) is well 
prepared for the report by: 

1. Data resides in an Excel spreadsheet 
2. It conforms to fundamental Excel database structural conventions. Data should adhere 

to these basic rules: 

1. Each column of the database should contain the data for a single field. 
2. Each row of the database should contain the fields relating to a single record. 
3. The first row of the database should contain the field names,. 
4. There should be no blank rows or columns embedded within the database. 

 
3. Two types of data fields in your spreadsheet. 

• Data: contains a value 
• Category: Describes the data  

It is very important that your data is in proper format, otherwise trying to use a PivotTable 
reports will not be effective. 

Pivot Table Terminology 

 PivotTable terminology to be familiar with: 

  

Axis A component or dimension of a PivotTable - row, column or page 

Field A column in the source Excel database 

Item A single member of a field 

Pivot To restructure the PivotTable by adding, deleting or moving fields 
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GET STARTED 

To set up a PivotTable, make sure the data in the spreadsheet conforms to Excel 
database conventions.  Be sure it has column titles and is in list format. 

 Insert a PivotTable 

1. Position the cell pointer anywhere within the range of cells defining the database.   
2. From the Insert Tab, in the Tables group, select PivotTables, then select PivotTable 

again. See figure below. 

  Figure – Insert a Pivot Table 
  

 

 

 

 

 

 

 

3. The Create PivotTable dialog box opens. See figure below. 

 Figure – Create PivotTable Dialog Box 
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4. The Select a table or range field is already selected for you. 

5. New Worksheet is also selected for you as the place where the report will be placed (you 
can select Existing Worksheet if you do not want the report placed in a new worksheet) 

6. Select OK 
  

Creating the PivotTable Layout 

The PivotTable layout area seen in the figure below is what you see in the new worksheet after 
you have selected OK to close the Create PivotTable dialog box.  

Figure – PivotTable Layout Area 

 

 

 #1   The layout area – Is to help you decide where the data should appear in the PivotTable 
report. 

#2    The PivotTable Field List.– Shows the column titles/categories from the source data 
worksheet and the drag and drop fields of a PivotTable. 

 
#3 PivotTable Area – Where the data will appear 
  
Each item in the PivotTable Field List can be selected and dragged to the PivotTable 
layout.   
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The table below describes the four areas used to arrange data in the PivotTable.  Page, Row 
and Column are axes of the PivotTable that contain the fields used to define how data is to 
be summarized.   

 Area Description 

Report Filter Displays data separately for each item in the field. 

Row Labels Displays items in the field as row labels. 

Column Labels Displays items in the field as column labels. 

Values Displays the values from the field in the body of the PivotTable.  This 
is the field on which you will perform a summary calculation.  

 

Build a PivotTable report  

  
1. Select an item in the field list 

2. Drag the item to a location in the “Drag fields between areas below” section in the 
PivotTable Field list box.  

3.  The results display at the left in the PivotTable as you drag and drop fields.  

4. Continue to drag fields to display in the area you want them to appear on the PivotTable. 
You do not have to use all the fields in the field list.  

5. The Data area MUST have at least one field in it. 

 CHANGE & MANIPULATE A PIVOTTABLE 

A pivot table is not a static object.  You can continue to modify and tweak it until it looks exactly 
how you want it to look.   Don’t worry about building a report incorrectly.  Excel makes it easy to 
try things out and to see how data looks in different relationships (areas of the report).  If a 
report is not how you want it at first, just lay out the data in another way by dragging the field to 
a different area. 

 Move Field List Items to a Different Field 

1. In the Drag fields between areas below section, left click and hold the mouse button 
down on the field you want to move.  See figure 4. 

2. Drag the field to another area of the report in this same section.   

3. The change is immediately apparent in the PivotTable report at the left.  
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NOTE   To remove a field from a report, clear the check box beside the field name in the 
PivotTable Field List.  To remove all the fields from the report so that you can start over, on 
the Ribbon, from the Options tab, in the Actions group, click the arrow on the Clear button, 
and then select Clear All. 

 Figure - PivotTableReport   

 
 

TIP   If you click outside of the layout area (of a PivotTable report) the PivotTable Field List 
disappears.  To get the field list back, click inside the PivotTable layout area or report. 

 To remove a field from the PivotTable, simply deselect the check box of the item in the 
“Choose fields to add to report:” area of the PivotTable Field List. 

 
 To add fields to the PivotTable, click the check box next to the item in the “Choose fields 

to add to report:” area of the PivotTable Field List. Next, drag the item to the appropriate 
field list area. 
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 To move a field around in the PivotTable, drag and drop the field list item to the new 
placement on the PivotTable area.  Either the Report Filter, Row Labels, Column Labels or 
Value area. 

 Dropping a field in the wrong position can produce very different results than what you 
expect.  If your pivot table is not analyzing the data quite the way you expect, try changing 
the relative positions of the row or column fields. 

 Multiple fields can be dropped into the report areas thus creating a multidimensional 
summary of the data.  The names of the fields and items can be changed simply by editing 
any occurrence of that particular field or item.  

NOTE The order in which you enter the fields in the row and column areas affect how the data 
in the PivotTable is grouped.  

 Pivot Data to get a Different View 

You can pivot the report data to get a different view of the data.  Pivoting a report, transposes 
the vertical or horizontal view of a field, moving rows to the column area or moving columns to 
the row area. 

 To pivot a field list item from a row to a column: 

1. Left click on one of the field list items in the Layout area 

2. From the short cut menu, point to the appropriate Move choice.  

Figure - Pivot a Field 
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Customizing a PivotTable Field 

There are several options available for fields within a pivot table.  To access these options: 

1. Right-Click field button on the PivotTable. See figure below. 

2. Choose Value Field Settings from shortcut menu. 

3.  Excel displays a PivotTable Value Field dialog box. (See figure below)  This field box 
can vary in appearance depending on the field button chosen.  

Figure - Value Field Setting Dialog Box 

  

Subtotals can calculate using many different functions, which are available in the Summarize by 
area of the dialog box.  The following are functions with explanations.   

  COUNT - how many occurrences 

 AVERAGE - arithmetic mean of occurrences 

 MAX - Maximum value 

 MIN - Minimum value 
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 PRODUCT - Product of all values 

 STDDEV - standard deviation 

 VAR - variance 

  

4. Any field can be modified: 

• Custom Name: Changes the name that is displayed on the field button on the 
PivotTable.   

• Summarize by tab: Lets you change the type of subtotaling that is displayed.  
Subtotaling is relevant only if you have more than one field displayed as rows or 
columns.   

• Show values as tab: Options on this Tab will change the way the value is 
compared.  See Figure 6 below for an example. 

  

Figure - Value Field Settings, Show Values as tab 
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Refresh a PivotTable  

If data is changed on the source spreadsheet refresh the PivotTable by: 
 
 

1. From the Data Tab in the Connections Group select the small drop down arrow 
next to the Refresh All command button. 

2. Choose Refresh from the option menu. 

 Filter PivotTable Items 

 PivotTable items can be filtered in much the same way that items of an Excel Spreadsheet.  
Column Labels and Row Labels both can be filtered on a PivotTable. 

1. Filter Arrow indicators appear on both the Column Labels and Row Labels field. See 
figure below. 

 

Figure  - Filter Arrow indicators on the PivotTable. 

  
   

2. Left Click the filter arrow.  
 
3. From the sub menu, clear the (Select All) check box in the list. (see figure below)  That 

clears the check boxes next to every item in the list. 
 

4. Select the check box next to the item to be filtered.  The PivotTable report will show only 
the data for that item.  
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Figure  - Filter arrow sub menu 

  

TIP  It is not always easy to tell if data has been filtered or not. When an item is filtered, the 
filter icon arrow changes.  A filter icon also appears next to the field name in the PivotTable 
Field List.   

  

Figure – Filter Icon Changes 
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Narrow the Filter  

Filtering can be narrowed to show only specific items within the filter.  Filter the report to a single 
type by using the following method: 

1. Select the range of cells for the single item type. See figure below. 

2. Right-Click and point to Filter 

3. From the sub menu select Keep Only Selected Items    

Now just the item type data selected should be displayed.  The new filter hides all the other 
items. 

Figure - Narrowing the Filtering of data in a Pivot Report 
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SUMMARIZE DATA OTHER WAYS 

There are so many different options for viewing and changing data in a Pivot Report.  Suppose 
you want to change the report from a sum function for adding amounts to count function.   This 
could be helpful when wanting to look at totals in quantities bought or sold. 

Change the Value to Count Function 

The figure below shows data collected to track salespeople, product, amounts along with other 
fields.   
Figure –Sample Data Spreadsheet 
 
 
 
 
 
 
 
 
 
 
 

 

The figure below is a Pivot Report created to look at this data by sales person and total amount 
sold by salesperson. 
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To change the function of a value in the Value area of the report: (Sum of Amount) to a Count 
function: 

1. Right-Click on the Subtotal amount value.  See figure below 

 

2. From the shortcut menu, point to Summarize Data by 

3. From the Submenu, Select Count.  This changes the Value column from a totaling Sum 
function to a Count function.  

4. The data in the Value field now reflects a number count of sales by each salesperson.   

Change the Value to Percent of Total Function 

Using the data we have and the Pivot report created from this data now we want to see what 
percentage of the grand total of sales was made by each salesperson.  We can use the 
custom calculation option to create a running total, or calculate percentage.    
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 To do this: 
1. Right-click in the Values area. See figure below 

 
2. From the shortcut menu, point to Summarize Data by 
3. From the Submenu, Select the More Options. 
4. The Value Field Settings dialog box appears. See figure below. 
5. Select the Show values as tab. 
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6.  From the Show values as field, use the drop down arrow at the right of the field, scroll 
down to select % of total.  

7. Click the OK button 
  
The Pivot Report Sum of Amount column changes to now reflect percentages.  See Figure 
below.  
 
 Figure  - Change Sum of Amount to reflect percentages. 

 

There are other custom calculations that can be performed using the same steps as previous.  
On the next page you will find a table that lists each of those custom calculation functions and 
their results 
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Custom Calculations 
 

Function Result 

Normal Turns off custom calculations 

Difference From 
Displays values as the difference from the 
value of the Base item in the Base field 

% Of Displays values as a percentage of the value  

% Difference From 
Displays values as a percentage difference 
from the value  

Running Total In 
Displays value for successive items in the 
Base field as a running total 

% of row 
Displays the value in each row or category as 
a percentage of the total for the row or 
category. 

% of column 
Displays all the values in each column or 
series as a percentage of the total for the 
column or series. 

% of total 
Displays values as a percentage of the grand 
total of all the values or dat points in the 
report.  

Index   
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 TRAINING AND SUPPORT  

IT Training  

Contact Us:  
IT Training & Development  
Phone: (818) 677-1700 or x1700 (on campus)  
Email: 
 

training@csun.edu  

Troubleshooting and Support  
If you experience problems getting started with Office 2007 contact the Help Center at x1400 or 
helpcenter@csun.edu. 
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NOTES 
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